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Introduction to APl basedPData Exchange

Tools and Prerequisite Settings

THIS SECTION CONTAINS'A BRIEF INTRODUCTION TO FHE ARl BASED DATA EXCHANGETOOES ANDIIHE
PREREQUISITES FOR USING THEM

DXC Assure Claims | Release: v.23.4 | December 2023

Introduction to APl Based Data Exchange
Tools

DXC is strategically working towards creating an API based Import/Extract Tool which would negate
dependencies on SAP interfaces requiring additional licensing.

— - API Based
-IX\- DXC Assure Claims Data

TECHNOLOGY Exchange

@

The table below shows the release calendar for the new API based Data Exchange tools:

© 2023 DXC Technology Company. All rights reserved.
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Name of Module | Assure Claims version GA

PUS 23.4
MMSEA 233
MBR 22.3
PositivePay 223
1099 23.1

SAP configuration will no longer be required to run the new API based Import/Extract
tasks.

The new API based Data Exchange solutions will only be accessible via the Configuration
Manager zone.

The respective DA SAP based modules (in the Utilities zone) will not be supported
simultaneously with the new API based solution (in the Configuration Manager zone).
Thus, with the release of DXC Assure Claims v. 23.1, MBR, PositivePay and 1099 tasks will
no longer be available through the old task manager in the Utilities zone.

It is imperative that all the prerequisite settings are performed to get the new APl based
Data Exchange modules functional.

Prerequisite Settings

The following one-time settings need to be done in the Configuration Manager/Utilities zones to perform
Data Import/Extract operations. It is imperative that these settings be performed in the exact order
mentioned below.

1. Select the checkbox labeled Use Rule Engine under General System Parameters.

A License Key will need to be entered to enable the checkbox labeled Use Rule Engine.

Please contact Assure Claims Support Helpdesk for assistance.
There are no additional costs associated with generating a License Key for enabling the
Rule Engine feature

© 2023 DXC Technology Company. All rights reserved.
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If you're using the Configuration Manager, navigate to Use Rule Engine checkbox as shown in [Fig. 1]

System Parameters Claims Module (tab)
Setup > General - Rule Engine
System Parameters (subtab)

Configuration

Manager (zone)

DXC Assure Claims (Configuration Manager) screen

=X

€ RMIUT201_ACOFF_FRESH [ DefaultView bi2141bi214 = =]
TecunoLooy
Workin Progress General System Parameters > e x
=] system 2 Employee (=) Diaries / Text Fields £ Claims Module @ Third Party Module

Evaluation Mode Duration

Use Rule Engine

Fraud Analytics Suite

Import/Extract Tool

Line Of Business
Media View Interface
Medical Management
QOFAC

PaperVision Document

Policy Interface

Rule Engine

Script Editor

[Fig. 1]

If you're using the Old Utilities, navigate to Use Rule Engine checkbox as shown in [Fig. 2]

System Parameters

Utilities (zone) - General System System Settings (tab)
Parameters Setup

DXC Assure Claims (legacy Utilities) screen

Utilities / General System Parameter Setup

General System Parameter Setup

Funds Settings Employee Settings Diaries / Text Fields Policy Interface Settings Globalization Settings

Department For Auto Population: B a

Use Single Sign On:
| Use Rule Engine: u |

[Fig. 2]

2. Mandatory requirement of a Database Server (either PostgreSQL or MongoDB)
for all APl based Import tools

A Database Server (either PostgreSQL or MongoDB) must be installed to act as a Staging area for all
Data Import Tools.

© 2023 DXC Technology Company. All rights reserved.
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DXC recommends the use of PostgreSQL as it is completely free to use
MongoDB (enterprise) may also be used, but it must be noted that it is a licensed
software for which additional costs will need to be paid

The PostgreSQL software may be downloaded on the Application Server itself or any
other server on the same network. However, it must be ensured that direct connectivity
to the Application Server is always maintained. A cloud-based service may also be used
for the same

e https://www.enterprisedb.com/downloads/postgres-postgresqgl-downloads

Customers hosted with DXC may please contact the Assure Claims Support Helpdesk to
get PostgreSQL installed

Any version of PostgreSQL (13.9 or higher) may be installed for your Operating System
Please keep the connection information handy before proceeding with the next steps

An example of a Staging Connectionstring

ID=<User|D>;Password=<password>;Server=localhost;Port=5432;Integrated
Security=true;Pooling=true;

Note

> Enter the ‘UserID’ and ‘password’ used during PostgreSQL setup

> If PostgreSQL is installed on the Application Server, then Server should be left as
“localhost”. Else, enter the server's name where PostgreSQL has been installed
The default PostgreSQL Port is 5432, however if a different port is used, please enter it
accordingly

3. Select the checkboxes - Use Import Tool and Use Extract Tool in the
Configuration Manager Zone

Navigate to the Import/Extract Tool subtab:

) . System Parameters Claims Module (tab)
Configuration

Manager (zone)

Setup > General ->Import/Extract
System Parameters Tool (subtab)

And select the checkboxes labeled Use Import Tool and Use Extract Tool. [Fig. 3]

© 2023 DXC Technology Company. All rights reserved.
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DXC Assure Claims (Configuration Manager) screen

N\~ —
.IXM £ RMIUT201_ACOFF_FRESH  [Z] DefaultView bi2141bi214 = =]
TECHNOLOGY
Work in Progress General System Parameters > c X
=] system £ Employee [=) Diaries / Text Fields £ Claims Module @ Third Party Module

Evaluation Mode Duration

T Aalylcs St Use Import Tool @ Use Extract Tool @

Import/Extract Tool

File Location @
Shared l SFTP -

SFTP Server Userld Password Folder Location

S3(AWS Storage)

Import Tool Database Type Import Tool Staging Database” Staging Connectionstring”

PaperVision Document -

Policy Interface

Rule Engine

[Fig. 3]
The File Location dropdown field has 3 options:

» Shared
> SFTP
» S3 (AWS Storage)

4 N
When the selected File Location is SFTP, then the following fields will be displayed:
» Server » Import Tool Database Type*
» UserID » Import Tool Staging Database*
» Password » Staging Connectionstring®
» Folder Location

When the selected File Location is S3(AWS Storage), then the following fields will be displayed:

» File Path* » S3 Region*

» S3 Bucket Name* » Import Tool Database Type*

» S3Access Key » Import Tool Staging Database*
» S3Secret Key » Staging Connectionstring®

When the selected File Location is Shared, then the following fields are displayed:

» Shared Location

» Import Tool Database Type*

» Import Tool Staging Database*
» Staging Connectionstring®

© 2023 DXC Technology Company. All rights reserved.
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~

File Location

» This location will be used to place the Import Files as well as get the Extracts from DXC
Assure Claims

» A network shared path such a SFTP or S3 may be chosen by entering the necessary
details

Import Tool Database connection details

> Appropriate details for connecting to the Staging Database Server will need to be
entered

> If you are using PostgreSQL as staging database server, ensure that the database
which you entered in the field labeled “Import Tool Staging Database” [Fig.3] has
already been created on your PostgreSQL Database server before you import the
Import Tool package.

» Make sure that the Staging Connectionstring is accurate before proceeding to next
steps

- J

4. Select the checkbox labeled - API Flexible Searches, in the Security zone

For APl based Export Tool, navigate to the Security Management System screen and turn ON the
“API Flexible Searches"” for the user who would schedule the Task Manager Jobs. [Fig. 4]

Security 2>
Security

DataSources >
Module Security
Groups > User

API Flexible
Searches
(checkbox/node)

Module Access
Permissions >

Management RISKMASTER >

System

DXC Assure Claims screen

Security Management System
Security Management System

O 2 B e E K D8 & 0

Module Access Permissions

© RISKMASTER SECURITY
© Users
@ DataSources
© AC_Attach B9 2

© AC221_BES_Maint

© AC222_ERON_MCOFF
© devops_221

© RM201_Automation
© RM201NEW_BES

© RM212_AutoSmoke I @ [W AP Flexible Searches
@ RMIUT201_ACOFF_FRESH Q@ mClaim
© Permission To Login Q | W Entity
© Module Security Groups © [mPAYMENT
O abe W Appointments
© Adid

© Administrator

@ WModule Access Permissions
© | W|RISKMASTER

© [m|Catastrophe Maintenance

O [mlrisim Tanle
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5. Download Microsoft OLE DB driver

To run the Import tool for MDB file to support modules such as MBR, Microsoft OLE DB Driver must
be installed in the Application Server.
Download the Microsoft OLE DB driver below:

DOWNLOAD MICROSOFT OLE
DB DRIVER

6. Download the ImportTool and ExtractTool PACKAGE Files and import them into
the DXC Assure Claims system

IMPORTTOOL.PKG EXTRACTTOOL.PKG

Downloadable “PACKAGES” were first introduced in release version 18.3. To know more about
PACKAGE download and their import into DXC Assure Claims (formerly RISKMASTER Accelerator/DXC
Insurance RISKMASTER™), please click on the adjoining Release Notes document and refer to pages
15 and 22 for details.

READ THE RELEASE NOTES FOR
VERSION 18.3

Introduction of an ability to create and run
Custom Import / Extract Jobs

With the release of v. 23.1, DXC Assure Claims has made further progress towards the objective of delivering
API based Extract and Import Tools by negating any dependencies on SAP interfaces.

To this end, the ability to create and run Custom Import/Extract jobs via the new APl-based solution has
been introduced. The implementation caters to the Custom Data Exchange Requirements of both Import
and Extract jobs.

© 2023 DXC Technology Company. All rights reserved.
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The existing/scheduled Import jobs in the Claim Scheduler module will stop working once the
client environment are upgraded/migrated to the latest version. DXC strongly recommends
rescheduling the existing Import jobs after migration/upgrade to 23.1.

Customers desirous of using the Custom Import/Extract jobs feature should reach out to their
Sales Contact/Project Manager or DXC Assure helpdesk. Our Implementation services team

would then analyze your business requirements and help you implement the same.

All the Custom Data Exchange jobs will now run directly from the Claim Scheduler without any
dependency on SAP. It even negates the need for server access (via Citrix or otherwise).

If the login password for the admin user is updated after scheduling API-based Import/Export
job(s) (MBR, PPY, MMSEA, 1099 and PUS) then it is recommended that the job(s) be edited and
rescheduled to avoid encountering credentials authentication failure messages in the job
console logs.

DXC Assure Claims screen

[E] PositivePay-OP-703-Import-PositivePay X

Completed With Error [PositivePay)

12/20/2023 7:00:55 AM 2---12/20/2023 7:00:55 AM---Parsing arguments.
12/20/2023 7:00:55 AM Hosting Environment is null
12/20/2023 7:00:55 AM 2---12/20/2023 7:00:55 AM---Process started.
12/20/2023 7:00:55 AM 2---12/20/2023 7:00:55 AM---Read Configuration.
12/20/2023 7:00:55 AM 2---12/20/2023 7:00:55 AM---Get Optionset.
12/20/2022 7300555 AM 2---12/20/2023 7100185 AM——_httna://dev_assnre-alaime dwo-rmol com/olaimeani/dataanalytice/ontionsat/
12/20/2023 7:00:55 AM 1---12/20/2023 7:00:55 AM---Job execution interrupted due to errors.An error occured while fetching JWT.Authentication failed.
Please edit existing scheduled job once and try again.
> 12/20/2023 7:00:55 AM 1---12/20/2023 7:00:55 AM---Job execution interrupted due to errors.One or more errors occurred. (An error occured while
fetching JWT.Authentication failed. Please edit existing scheduled job once and try again.)
> 12/20/2023 73009535 AN 1===12/20/2023 770035 Al===Jub executivn interrupted due LU SLIvEs.0nNe UL MULE SILULS UCCULIed. (Al SLIivi UCCured wiile
fetching JWT.Authentication failed. Please edit existing scheduled job once and try again.)
> 12/20/2023 7:00:55 AM 1---12/20/2023 7:00:55 AM---Job execution interrupted due to errors.One or more errors occurred. (An error occured while
fetching JWT.Authentication failed. Please edit existing scheduled job once and try again.) System.Exception: An error occured while fetching
JWT.Authentication failed. Please edit existing scheduled job once and try again.
> at ImportTools.Helpers.JwtTokenAuth.GetRMAJWT(Globals Globals) in D:\ClaimsSchedulerAPI\data-exchange-
libs\Claims.ImportTool\Helpers\JwtTokenAuth.cs:line 62

> at ImportTools.Helpers.CommonService.GetAsync(String surl, Globals Globals) in D:\ClaimsSchedulerAPI\data-exchange-

libs\Claims.ImportTool\Helpers\Common.cs:line 394
> at ImportTools.Helpers.CommonService.CallAPI(String url, String methodtype, Object inputobject, Globals Globals) in D:\ClaimsSchedulerAPI\data-
exchange-1ibs\Claims.ImportTool\Helpers\Common.cs:line 368

[Fig. 5]

© 2023 DXC Technology Company. All rights reserved.
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[E) PositivePay-OP-702-Export-PositivePay X

Completed With Error [PositivePay])

12/20/2023 6:42:52 AM "Process started."

> 12/20/2023 6:42:52 AM Hosting Environment is null
> 12/20/2023 6:4 "argument count is19"

> 12/20/2023 6:4 "user isviniteaml"

> 12/20/2023 6:4 "dsnRMIUT201_ACOFF_FRESH"

> 12/20/2023 6:4 "submoduleCoM"

> 12/20/2023 6:4 “Job Id is4218"

> 12/20/2023 6:4 "Optionset Id is702"

> 12/20/2023 6 “Getting Optionset"

> 12/20/2023 6 "Gettina JWT Token."

> 12/20/2023 6:42:52 "Error occurred in Class Name: Claims.ExtractTool.Services.JwtTokenAuth, Method Name: GetRMAJWT, Line Number: 69 Error message
is: An error occured while fetching JWT:

> Authentication failed. Please edit existing scheduled job once and try again.

.

> 12/20/2023 6:42:52 AM An error occured while fetching JWT:

> Authentication failed. Please edit existing scheduled job once and try again.

>

Procuring APl based DE Tools

The procurement of APl based DE Tools may involve additional cost/ consulting/ agreement/ licensing
considerations.

Please reach out to DXC Assure Claims Support or your DXC Assure Claims Sales Representative for more
information.

© 2023 DXC Technology Company. All rights reserved.
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Supported APl Based Data Exchange Tools

THIS SECTION CONTAINS DESCRIPTIONS OF ALL THE API BASED DATA EXCHANGE TOOLS FOR WHICH THE
NEED OF SAP INTERFACES HAS BEEN NEGATED

DXC Assure Claims | Release: v.23.4 | December 2023

MBR Import

To schedule an MBR Import job, go to Configuration Manager - Task Manager - Scheduler section - Job
Details - and schedule a Task by selecting MBR as Task Type and Import Tool as Sub Task Type.

Enter required data in the StartDate /End Date and Job Scheduler section. Next, enter the frequency of job
execution in Job Scheduler to get redirected to the OptionSet Parameters tab. [Fig. 6]

© 2023 DXC Technology Company. All rights reserved.
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DXC Assure Claims screen

Task Manager

PEL L ET Scheduler

Job Detail Start Date / End Date Job Scheduler OptionSet Parameters

Option Set Information Entity Match Settings Payment Options Fee Payments

Optionset Name File Name Bypass Script Editor Allow Creation of New Entities
MBR_Import Op_Import [:] D

Perform Verification Bypass Activity Logs Import Task Type File Format

& MDB format For Corvel(Without Line It... ¥

Mode Type

BOTH Validation and Data Import (... w

PREVIOUS

New optionset information has been added for MBR import for duplicate validations

OXC TeEcHNOLOGY & RMIUT201_ACOFF_FRESH [Z] DefaultView 2 General Enhancements = 3]
Work in Progress Claim Scheduler > o x
—Elosls 2§ Dashboard E] Jobs @ Scheduler

\(1) Job Detail ° OptionSet Parameters
Option Set Information Entity Match Settings Payment Options ’ Duplicate Criteria Options Fee Payments
Exclude Invoice Number Include Voids In Search Use Service Dates Not Trans Date
O @] O
[Fig. 6]

The Optionset Parameters tab includes 4 sub-sections namely, Option Set Information, Entity Match
Settings, Payment Options, Fee Payments. Enter relevant data in the respective fields of each section.
Based on the selections made on this screen, the task will be scheduled. The created task will be displayed
on the Jobs section of the Claim Scheduler screen. [Fig. 7]

© 2023 DXC Technology Company. All rights reserved.
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For complete information on MBR Optionset Parameters, please
refer to the DA MBR Optionset User Guide document on the LOG INTO DXC CLAIMS

Claims Microsite > DXC Assure Claims Release Info >Data MICROSITE
Analytics > DE Modules Optionset User Guides > MBR

DXC Assure Claims screen

Task Manager

Dashboard Scheduler

Aborted

Filter by column name....
Completed 1 to 25 of 41 Page:10of2 » >l

Completed Wit...

Job Name Description Job State Start Date/Time End Date/Time Job Files
Running Completed

MBR-OQP-139-Im DA_MBR 3 06/23/2022 12:44 PM 06/23/2022 12:44 PM n
Task List Completed i

MBR-OP-91 DA_MBR ] 06/23/2022 12:42 PM 06/23/2022 12:43 PM n

[
Total Jobs Exe... MBR-OP-91 DA_MBR = 06/23/2022 12:41 PM 06/23/2022 12:41 PM [ ]

[Fig. 7]

To edit the scheduled job, select the clickable link to get redirected to the respective screen. To remove the
same, select the corresponding checkbox, followed by the Delete button from the top right corner.

Note

» With the new API based MBR Import solution, the need to create a Reserve prior to

importing a payment has been resolved. You can now Import Payments without
Reserves as the system will automatically create the required Reserves in the
background

MBR Extract

To extract for an MBR (Medical Bill Review), go to Configuration Manager - Task Manager - Scheduler
section - Job Details. Mentioned below are the various fields pertaining to it are mentioned below.

Schedule a Task with the Task Type - MBR and Sub Task Name - Extract. Secondly, enter required data in

the StartDate /End Date and Job Scheduler section. Next, in the Medical Bill Review - Optionset
Parameters tab, enter a unique name for the Optionset and select Export Type. [Fig. 8]

© 2023 DXC Technology Company. All rights reserved.
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DXC Assure Claims screen
Task Manager

Dashboard Scheduler

Job Detail 2 Start Date / End Date 3 Job Scheduler OptionSet Parameters

Medical Bill Review -> Optionset Parameters Medical Bill Review -> Entity Extract

Optionset Name Export Type

Op_Extract ENTITY Entity

PREVIOUS
[Fig. 8]

There are two types of Export Type namely, Entity and Claim. Depending upon the selection made in this
field, the Medical Bill Review - Entity Extract or Medical Bill Review - Claim Extract section will be
correspondingly displayed. Enter relevant data in the respective sections and select the Save button. The
created job will be displayed in the Task Manager - Jobs tab - Task List section. [Fig. 9]

DXC Assure Claims screen

Task Manager

Dashboard Scheduler

Aborted

Filter by column name....
Completed 1to 25 of 41 Page:10f2 > >l

Completed Wit...
Job Name Job State Start Date/Time End Date/Time

Running [
MBR-OP-405-Ex... 06/23/2022 12:44 PM 06/23/2022 12:44 PM

Task List Completed
MBR-OP-403-Ex... 06/23/2022 12:42 PM 06/23/2022 12:43 PM

Completed
EE B MBR-OP-402-EX... 06/23/2022 12:41 PM 06/23/2022 12:41 PM

Completed
MBR-OP-399-Ex... 06/23/2022 12:36 PM 06/23/2022 12:36 PM

[Fig. 9]

To edit the scheduled task, select the clickable link to get redirected to the respective screen.

While the Task Manager screen of the MBR Extract Tool has been completely redesigned
and given a modern look and feel, its functionality has not been altered.

The details of an existing MBR Extract job will be prefilled in the respective fields if the
same task is created again.

The data will be auto populated based on the selected Task Type and Sub Task Name.

© 2023 DXC Technology Company. All rights reserved.
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PositivePay Import

Go to Configuration Manager > Task Manager > Scheduler section. This section features two tabs, namely,
Job Detail and OptionSet Parameters. In the Job Detail tab, schedule a Task with the newly added Task
Type - PositivePay and Sub Task Type - Import. Next, enter relevant data in the fields of the OptionSet

Parameters tab and select Save.

DXC Assure Claims screen

Task Manager >

2§ Dashboard EJ] Jobs @ scheduler

@ Job Detail

e OptionSet Parameters

Positive Pay
Optionset Name” Import Task 1ype* Import 1ypex File Name”
Optionset_PositivePay CLEARCHECK v ppyijﬁ
Mode Type® File Format™
BOTH Validation and Data Import (Rec... v ACCOUNT_NUMBER_LENGTH_13 13-
[Fig. 10]

Based on the selections made on this screen, the task will be scheduled, and the PositivePay Import job
along with the job files will be displayed in the Jobs section of the Task Manager screen. [Fig. 11]

DXC Assure Claims screen

Task Manager >

25 Dashboard E] Jobs @ scheduler

Aborted 0
Filter by column name....

Completed 296 1 to 25 of 226 Page: 1 of 10 c o
Completed Wit... 209
C] Job Name Description Job state Start Date/Time End Date/Time Job Files
Running Completed
D PositivePay-OP-... DA_PositivePay 09/09/2022 7:50 AM 09/09/2022 7:52 AM n
Task List 0 X ) Completed
D PositivePay-OP-... DA_PositivePay 09/09/2022 7:48 AM 09/09/2022 7:50 AM n
Completed
Total Jobs Exe... 433 () PositivePay-OP-.. DA PositivePay 09/08/2022 827 AM 09/08/2022 827 AM [ :]
[Fig. 11]
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PositivePay Extract

The Job for the PositivePay Extract tool can be scheduled and executed like any other job. For this, go to
Configuration Manager - Task Manager - Scheduler section. This section features four tabs, namely,

Start Date / End
Date

OptionSet

Detail
Job Deta Parameter

Job Scheduler

In the Job Detail tab, schedule a Task with the newly added Task Type - PositivePay and Sub Task Type -
Extract. In the following tab, enter select the required Start Date and End Date. Next, enter the frequency of
job execution in Job Scheduler to get redirected to the OptionSet Parameters tab.

DXC Assure Claims screen

Task Manager

Dashboard Scheduler

Job Detail Start Date / End Date Job Scheduler OptionSet Parameters

Positive Pay

Optionset Name File Name Company Name/Title Manually Change Date Ra...

Optionset_PositivePay OP_PositivePay

Date From Date To Bank Format Bank Account

dd/MM/yyyy dd/MM/yyyy COMBZ CommBiz — 1234567899 Set-Up __

PREVIOUS

[Fig. 12]

This tab includes the following fields:

» Optionset Name Bank Format

>
» File Name » Bank Account
» Company Name/Title » Bank Account
» Manually Change Date Range » File Format
» Date From » Destination/Receiving Location
» Date To

Based on the selections made on this screen, the task will be scheduled, and the PositivePay will be
extracted. The created task will be displayed on the Jobs section of the Task Manager screen. [Fig. 13]
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DXC Assure Claims screen
23/06/2022 3:25 P... 23/06/2022 3:25 P...

Dashboard Jobs Scheduler

Aborted

Filter by column name....
Completed 1to 25 of 41 Page:10f2 » >l

Completed Wit...
Job Name Description Job State Start Date/Time End Date/Time

Running N [
PositivePay-OP-  DA_PositivePay

Task List Compietea
MBR-OP-403-Ex... DA_MBR

5]

23/06/2022 325 P... 23/06/2022 325 P...

06/23/2022 12:42 PM 06/23/2022 12:43 PM

2]

Total Jobs Exe... Completed

MBR-OP-402-Ex... DA_MBR 06/23/2022 12:41 PM 06/23/2022 12:41 PM

2]

[ ]

MBR-OP-399-Ex... DA_MBR 06/23/2022 12:36 PM 06/23/2022 12:36 PM

(5]

[Fig. 13]

To edit the scheduled task, select the clickable link to get redirected to the respective screen.

While the Task Manager screen of the PositivePay Extract Tool has been completely

redesigned and given a modern look and feel, its functionality has not been altered.

The details of an existing PositivePay Extract job will be prefilled in the respective fields if
the same task is created again.

The data will be auto populated based on the selected Task Type and Sub Task Name.

1099-MISC and NEC Extract

The 1099-MISC And NEC task type is now available on the Claim Scheduler screen of the Configuration
Manager zone.

With this integrated solution, the 1099 details can now be retrieved through an Extract tool without the
involvement of SAP configuration. The 1099 form is used to report non-employment income to the Internal
Revenue Service (IRS).

To extract the same, go to Configuration Manager > Task Manager > Scheduler section. In the Job Detail
section, schedule a Task with the newly added Task Type - 1099-MISC And NEC. Enter relevant data in the
fields of the Start Date/End Date and Job Scheduler tab.

Next, select necessary filter criterion in the Optionset Parameter section. [Fig. 14]
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DXC Assure Claims screen
Task Manager >

2§ Dashboard EJ Jobs @ scheduler

(2)(8)

@ Job Detail @ Start Date / End Date @ Job Scheduler ° OptionSet Parameters

Option Set Information Settings Reserve/Transaction Settings Payee Settings
Optionset Name” Specify Date Range Date From Date To
1099_Optionset MM/dd/yyyy D MM/ddryyyy D
Tax Year to Export Last Month Extract
Last Week Extract RollUp Payments on Export
[Fig. 14]

Based on the selections made here, 1099 details will be extracted once the job is executed successfully. The
created task will be displayed on the Jobs section of the Task Manager screen. [Fig. 15]

DXC Assure Claims screen
Task Manager >

Cc X
28 Dashboard EJ Jobs @ scheduler
Aborted 0
Filter by column name....
Completed 090+ 1 to 25 of 9968 Page: 1 of 399 c 0o
Completed Wit... 999+
D Job Name Description Job State Start Date/Time End Date/Time Job Files
Running Completed
099-MISC And ... — 08/28/2022 5:49 PM 08/28/2022 5:43 PM B
; Completed
Task List 0 D 1099-MISC And ... DA_1099-MISC And ... — 08/25/2022 6:39 AM 08/25/2022 6:39 AM B
[Fig. 15]

Note

» The legacy DA 1099-MISC and NEC task is no longer available via the Utilities zone. This
task can only be accessed via the Configuration Manager zone.
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Addition of Entity Type filter options for Box 6

1099-MISC Reporting for Box 6 has been refined with the addition of new selection criteria - Entity
Category and Entity Type. With this enhancement, organizing and searching across 1099-MISC records
has been made easier as 1099 Reporting for Box 6 can be refined from a list of Reserve Types as well as
from a Subset of Entity Types.

Note

> For systems configured with the System Setting Entity Role marked as ON,
e The box listing the Entity Category will be displayed.

e The box listing the Entity Type and People Type will be disabled.

» For systems configured with the System Setting Entity Role marked as OFF,
o The box listing the Entity Type and People Type will be displayed.
e However, the box listing the Entity Category will be disabled.

After the settings are aligned in place, schedule a 1099-MISC and NEC job from the Task Manager screen.
For this, follow the path mentioned below:

Configuration Task Manager Seliaalilar G0 Schedule 1099-

Manager (zone) (screen) MISC and NEC Task

Based on the System Setting, the Reserve/Transaction section will feature new fields, Box 6 Entity Category,
Box 6 People Type or Box 6 Entity Type field. Make necessary selections and execute the job. The data will
be extracted based on the filters applied on the Optionset as well as the Reserve/Transaction screen. [Fig.
16]
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DXC Assure Claims screen

€ RMIUT201_ACOFF_FRESH Defaultview
Claim Scheduler >

23 Dashboard E Jobs @ scheduler

gm b2141bi214 = ]

@ Job Detail ° OptionSet Parameters

(2)(a]

Option Set Information Settings Reserve/Transaction Settings Payer Settings
Export All Payments for Tax Year Export Specific Transaction Types @ Export Specific Reserve Types @
Search - Search
Box 6 Medical Reserve Type Box 6 Entity Category Box 6 People Type Box 6 Entity Type
Search A4 Search A4 Search Search -
Box 10 Transaction Type Box 13 Transaction Type
Search - Search -

Note

» Moving forward, this feature will be available only in the new API based solution

(Configuration Manager zone). That is, DA 1099 Task will be removed from the legacy
Utility zone.

MMSEA Import and Extract

The ability to create and run MMSEA jobs via the new API-based solution is now available via the
Configuration Manager zone. The Scheduler screen now features a Optionset window for MMSEA Query

and Claim jobs.
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MMSEA Query/Claim Input via API-based Extract Tool

Navigate to the path mentioned below to avail the feature and schedule a MMSEA Claim Input job:

Configuration Manager - Claim Scheduler - Scheduler - Job Details - and schedule a Task by
selecting MMSEA as Task Type and Export as Sub Task Type. [Fig. 17]

DXC Assure Claims screen

Claim Scheduler > c x

%% Dashboard El Jobs @ scheduler

° Job Detail
© Job Details
Task Type Task Name Sub Task Name Run Immediately
MMSEA -  MMSEA Export ~ 0O
Email Notification
Diary Notification Send Notification Send Notification To
@ When Tasks are executed with... .,
[Fig. 17]

Next, enter the frequency of job execution in Job Scheduler to get redirected to the Option Set Information

tab.

In the Optionset Parameters tab, enter relevant data in the mandatory fields namely,

>
>

Optionset Name: Enter a unique name for the Optionset.

RRE ID: RRE ID can be defined from the Assure Claims fields. There are three fields, Client
Information, Department Level and the Policy Level.

File Format: There are two formats available to choose from, wherein Claim (new added) exports
the Claimant & Claim details and Query exports the Claimant details only.

Claim Type: Select the Claim Type from the dropdown list.

Enable the Test Export checkbox.
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DXC Assure Claims screen

Claim Scheduler > c x

2§ Dashboard £l Jobs @ scheduler

@ Job Detail e OptionSet Parameters
Option Set Information Diary Settings
Optionset Name RRE Id” File Format~ Test Export
MMSEA-Optionsed 16 «  CLAIM Claim > 2
Export Only Primary Claimants Do not Include TPOCs Under Threshold Claim Typek
'd
D D |\ PREM Premises Liability )
T o
| LT Lost Time )
. /
Search hd
[Fig. 18]

Next, move to next newly added tab, Diary Settings. Select the checkbox labelled, Send Diary To Current
Adjuster, if needed.

Based on the selections made on this screen, the task will be scheduled, and the data will be extracted.

MMSEA Query/Claim Response job execution via APl-based
Import Tool

Similarly, the MMSEA jobs can be scheduled for Imports as well. To schedule a MMSEA Import Type task, go
to Claim Scheduler - Scheduler - Job Details - and schedule a Task by selecting MMSEA as Task Type
and Import as Sub Task Type.

Fill relevant data in the Optionset Parameters tab:

» Optionset Name: Enter a unique name for the Optionset.
> Import Type: The field features two options:
e CLAIMANTMMSEA: CLAIMANTMMSEA can be used to import the Claimant & Claim details
via Claim file format and the Claimant details via the Query file format.
e TINMMSEA: This retrieves the RREID information by using this option.
» File Name: Enter the name of the file for which the import is being executed.
> RRE ID: RRE ID can be defined from the Assure Claims fields. There are three fields, Client
Information, Department Level and the Policy Level.
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» File Format: There are two formats available to choose from, Claim (new added) and Query.
» Mode Type: Select the option Both Validation and Data Import.

DXC Assure Claims screen
Claim Scheduler >

Cc X
u= e
=8 Dashboard £l Jobs @ Scheduler
® (2
(1) S
W, Job Detail OptionSet Parameters
Option Set Information Diary Settings
Optionset Name’ Import Task Typex Import Typex File Name
TINMMSEA v MMSEAM
RRE Id” File Format™ Mode Type
220821 - QUERY Query - BOTH Validation a... -
[Fig. 19]

Select the checkbox labelled, Send Diary To Current Adjuster, in the Diary Settings tab, if required.

The created task will be displayed on the Jobs section of the Claim Scheduler screen and the data will be
imported.

Improvements in APIl-based Import and
Extract Tool in the Claims Scheduler screen

The API-based Extract and Import Tools introduced in the previous releases have been further enhanced to
provide better usability in release version 23.4.

New Diary Sharing Option in MMSEA Import & Extract Tool

Earlier, the MMSEA Import & Extract jobs via the new APl-based solution allowed diaries to be shared
exclusively with the current adjuster. However, the latest release version of Assure Claims enables the
sharing of diaries with additional users as well. This enhancement has been achieved through a newly
introduced Send Diary to Additional Users option in the OptionSet Parameters section of the MMSEA
Import/Extract job screen. To access this capability, schedule a MMSEA task and in the Dairy Settings tab of
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the OptionSet Parameter section, select the newly introduced checkbox, Send Diary to Additional Users.
[Fig. 20]

DXC Assure Claims Screen
Claim Scheduler > X

%% Dashboard El Jobs @ scheduler

()]

-
D) © ovisetporamcc
‘\ ®, Job Detail OptionSet Parameters
Option Set Information Diary Settings
Send Diary o Send Diary to Additional Users Select user
O %) ( team1 team1 9 )
- J

Search v

[Fig. 20]

PUS Import Tool

The primary objective of PUS Import tool is to update payment files received from third-party sources.
Consequently, the payment data is automatically populated into the Assure Claims system once the import
job is successfully executed.

However, this release version of Assure Claims introduces the API-based PUS Import Tool feature as
part of Phase 1 implementation. This API-based solution will undergo further enhancements to

incorporate additional features in upcoming releases.

Scheduling a PUS Import job

To schedule a PUS Import job, go to Configuration Manager - Claim Scheduler - Scheduler section - Job
Details » and schedule a Task by selecting PUS as Task Type. Next, in the OptionSet Parameters tab, fill
in the following fields.

» OptionSet Name: Enter a unique name for the OptionSet.
» Import Task Type: Payment Update System will be displayed as a default option in this field.
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» Import Type: There are two Import Types available, Payment and Payment Details. Choosing the
Payment option will result in an update to the Funds/Transaction screen, whereas selecting the
Payment Details option will update the Transaction Detail/Funds Split Detail screen.

» File Name: Enter the file name filename of the document that was previously uploaded based on
the Field Mapping Document in the location indicated on the General System Parameter screen.

» Mode Type: This field includes three options namely, Data Import, Validation & Validation and
Data Import. In case, Validation and Data Import or Validation option is selected, then, the File
Name field will become active. It will remain inactive if Data Import option is selected.

» Update Even if Blank or Zero: If this checkbox is selected, then, the job will be executed even if the
fields are blank.

DXC Assure Claims Screen
Claim Scheduler > c x

2% Dashboard El Jobs @ scheduler

( \
{ 7/‘ Job Detail e OptionSet Parameters

Option Set Information

Optionset Name Import Task Type Import Type File Name”
v
Mode Type’ Update Even if Blank or Zero
BOTH Validation a... v D
[Fig. 21]

Enter relevant data in the fields and select Save to run the job. Based on the selection, the data will be auto
populated in the Funds/Transaction screen and Funds Split screen respectively.

Supplemental Field Mapping in PUS Import tool*

A new subtab labeled Supplemental Field Mapping is now available on the OptionSet tab to include
supplemental data mapping while scheduling a PUS job. It must be noted that the Supplemental tab on PUS
Optionset screen is visible only when Payment option is selected as the Import Type and Data Import is
selected in the field labeled, Mode Type.

Supplemental Field Mapping subtab screen components
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The Supplemental Mappings grid available on this subtab consists of 46 Payment Supplemental rows
labeled FUNDS_SUPP_1... up till FUNDS_SUPP_46.

The grid consists of the following columns:

» Field Name » Supplemental Table
> Mapped » Supplemental Field

DXC Assure Claims screen

Claim Scheduler > c X

| 2§ Dashboard El Jobs @ scheduler

@ Job Detail e OptionSet Parameters
Option Set Information Supplemental Field Mapping |
Supplemental Mappings
Payment Supplementals v
Field Name Mapped Supplemental Table Supplemental Field
FUNDS_SUPP_1 0
FUNDS_SUPP_2 D
FUNDS_SUPP_3 0
[Fig. 22]

The Mapped column consists of a checkbox, which if selected, will enable the dropdown fields in the
Supplemental Table and Supplemental Field columns. [Fig. 23]
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DXC Assure Claims screen
Claim SCheduIer> ¢ X

| 2§ Dashboard El Jobs @ scheduler

@ Job Detail ° OptionSet Parameters

Option Set Information Supplemental Field Mapping

Supplemental Mappings

Payment Supplementals v
Field Name Mapped Supplemental Table Supplemental Field
FUNDS_SUPP_1 @ FuNDS§UFP '} N
FUNDS_SUPP_2 D FUNDS_SUPP LSS_INVOICE_ID .
NETWRK_SRVC_CODE
FUNDS_SUPP_3 D
BILL_RCVD_DATE

BILL_RCDMBR_DATE
[Flg' 23] OTH_VEN_DOC_TEXT
BILL_DOC_NO_TEXT

BILL_REV_CM_EID

Upon enabling a checkbox under the Mapped column, it will be possible to map the corresponding
Supplemental Table with a Supplemental Field so that this mapped data is imported, upon successful
completion of the PUS Import job, and displayed in the Supplementals accordion of the Transaction screen.
[Fig. 24]

DXC Assure Claims screen
Event (sdf2023002823 * 1511/2023) © General Claim (GCDONeW002685) © Financials/Reserves /| Transaction (0003162) @

+ e faapmBa 0W|>90n =8

Transaction ?
Transaction Detail >
LSS Funds Info >
Supplementals -
Internal Claim Invaice ID
Q
Network Service Code Date Bill Received
[ |
Date Bill Revd By Review Co Other Vendor Decument Number
B
Bill Decument Number Bill Review Company
Qe
LSS History 1d LS5 User id

[Fig. 24]
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Validation Messages

The validation message “The selected Payment Supplemental Field(s) FUNDS_SUPP_1 has not been mapped”
is displayed when attempt is made to save the Supplemental Field Mapping without selecting a
Supplemental Field. [Fig. 25]

DXC Assure Claims screen
Claim Scheduler> CcC X

o The selected Payment Supplemental Field(s) FUNDS_SUPP_1 have not been mapped.

(]

@ Job Detail ° OptionSet Parameters

Option Set Information Supplemental Field Mapping

Supplemental Mappings

Payment Supplementals -
Field Name Mapped Supplemental Table Supplemental Field
FUNDS_SUPP_1 @ FUNDS_SUPP v N
FUNDS_SUPP_2 0 FUNDS_SUPP = =
[Fig. 25]

The validation message “Selected supplemental column LSS_INVOICE_ID is mapped more than once with the
field(s) FUNDS_SUPP_1 and FUNDS_SUPP_2" when duplicate selections are made in the Supplemental Field
column. [Fig. 26]

DXC Assure Claims screen
Claim Scheduler> ca X

o Selected supplemental column LSS_INVOICE_ID is mapped more than once with the field(s): FUNDS_SUPP_1,FUNDS_SUPP_2

=l

@ Job Detail e OptionSet Parameters

Option Set Information Supplemental Field Mapping

Supplemental Mappings

Payment Supplementals v

Field Name

Mapped

Supplemental Table

Supplemental Field

FUNDS_SUPP_1

FUNDS_SUPP

LSS_INVOICE_ID

FUNDS_SUPP_2

FUNDS_SUPP

-

LSS_INVOICE_ID
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The validation message “The Supplemental Field(s) LSS_INVOICE_ID is mapped multiple times with the
Field(s) : FUNDS_SUPP_1, FUNDS_SUPP_2" is displayed when the save button is clicked after making
duplicate Supplemental Field selections. [Fig. 27]

Claim Scheduler >

DXC Assure Claims screen

o The Supplemental Field(s) LSS_INVOICE_ID is mapped multiple times with the Field(s) : FUNDS_SUPP_1, FUNDS_SUPP_2_

@ Job Detail

Option Set Information

Supplemental Field Mapping

e OptionSet Parameters

Supplemental Mappings

Payment Supplementals
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Field Name Mapped Supplemental Table Supplemental Field
FUNDS_SUPP_1 FUNDS_SUPP w | LSS_INVOICE_ID
FUNDS_SUPP_2 FUNDS_SUPP w | LSS_INVOICE_ID

[Fig. 271
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DXC Assure Claims

DXC Assure Claims is an integrated Claims Administration Platform that consolidates multiple functions into
one cohesive solution to provide accurate and up-to-date business functions using the latest technology.

This browser-based software provides real-time analytics to help you spot trends and mitigate future losses.
It gives your staff a highly efficient system that simplifies workflows and promotes best practices throughout
your organization. It helps ensure that your claimants receive first-class service, besides providing your
management team with a means to track key metrics to control costs and improve performance.

Thousands of Risk and Claim professionals rely on DXC Assure Claims
READ MORE ON THE DXC CLAIMS . _ . .
CROE T to manage all types of Claims, making it one of the industry's leading
Claims Management Systems. This active client community ensures

that DXC Assure Claims is continually supported and enhanced -
keeping your Claims processing running smoothly today and in the
future.

DXC BLOG - INSURANCE &
TECHNOLOGY

Contact Us

The Assure Claims Support Center
provides manned telephone support
services at these times -

8:00 AM - 8:30 PM, EST, Monday
through Friday.

Additional and after-hours coverage
may be available upon request.

risksupp@dxc.com

@ 1-877-275-3676
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